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Find / Replace   

  

Inpage Urdu 2000  

File Menu :  
Selecting the File Menu allows you to select one of the following menu items  

New Document  

Displays a dialog where you can enter values for your new document. The attributes that 

can be set in this dialog are-  

Page: You can select one of the standard pages sizes from the Page Size combo box. 

Width/Height: If a custom size is desired, then you need to enter the Page Width and Page 

Height.  

Orientation:   

Portrait/Landscape: The pages in the document can either be in a Portrait mode or in a 

Landscape mode. In Portrait mode, the width and height that you specify are taken as such.  

Whereas in the Landscape mode, the widths and heights are interchanged.  

Pages: Specify here number of pages in the document with which you want to start your 

new document. If the Automatic Text Box check box is checked then the Text Boxes will 

appear on all these pages. You can later on choose Insert Pages menu option to add more 

pages.  

Margins: Specify the page margins as distances from the respective page boundary. At 

these positions page margin guides will be drawn and if an automatic Text Box check box 

(described later in this dialog) is checked on, then the new Text Box will lie along the 

margins.  

Direction: Specify the direction of text entered.  

http://inpageurdu.blogspot.com/2010/01/file-menu.html
http://inpageurdu.blogspot.com/2010/01/file-menu.html
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Left To Right: Check this option if you wish to have the text direction from Left to Right.  

Right To Left: Check this option if you wish to have the text direction from Right to Left. 

Columns: Specifies numbers of columns in the document. The number of columns in the 

document can later on be modified using Format Document menu option.  

Gutter: Specify the gap between columns.  

Automatic Text Box: If this option is checked then an automatic text chain appears on all 

the pages of your document. Thus you do not need to draw and link Text Boxes afresh. 

These Text Boxes are all linked in a text chain, so that text flows from one Text Box on a 

page to another Text Box on next page.  

Double Sided: If this option is checked, then your document will be double sided. You thus 

get two master pages, left master page and right master page. In a single sided document, 

you get only one master page which is applied to all the pages in the document.  

Facing Pages: If this option is checked then you can view the pages in your document in 

Facing Pages Mode. In facing pages, two pages are displayed at a time, with both pages 

displayed side by side. Whereas in non Facing pages, one page is displayed at a time. Save 

As Default: The Save As Default button saves the current values in the New dialog as 

application preferences so that the next time you make a new document, it automatically 

takes on these values.  

Open...  

On clicking the Open menu item in the File menu, (a standard) Open File dialog is 

displayed. You can open only those files which have been saved as InPage files, or as 

InPage Template files.  

File Name: Enter the name of file to be open.  
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List Files of type: Select the type of file to be open. The default extension for the InPage 

Page Layout file is "INP". The default extension for the Template file is "INT".  

Folders: Choose the appropriate directory where the file exists.  

Drives: Choose the appropriate drive.  

  

Close  

Selecting the Close menu item in the File menu, closes the topmost document. If some 

changes were made to the document then a prompt asking you to save the document 

appears. Save   

After having worked on a document, you can save changes made to the document by 

choosing the Save item from the File menu. If this was a completely new document which 

you are saving for the first time, you will be prompted with the Save dialog which includes 

the following options  

File Name: you can enter the file name under which you want this document saved. List 

Files of type: Select the type of file to save. The default extension for the InPage files is 

"INP".  

Folders: Choose the appropriate directory where to save. the file.  

Drives: Choose the appropriate drive.  

Save As...   

If you want to save a copy of this document under some other name, then choose this Save 

As menu item. A Save As dialog is displayed under which you want the copy of this 

document saved.  
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File Name: you can enter the file name under which you want this document saved. List 

Files of type: Select the type of file to save. The default extension for the InPage files is 

"INP".  

Folders: Choose the appropriate directory where to save. the file.  

Drives: Choose the appropriate drive.  

  

  

Collect For Output...   

If you want to output your file at a print bureau you will need to ensure that all the linked 

image files are copied along with the Inpage document file. To enable you to copy all the 

image files along with the document file to a user-specifiable directory, this command can 

be used.  

Place   

This menu item is used for placing images in InPage in its original dimensions. On 

choosing this menu item, you will be prompted with Place Picture dialog box. You can now 

choose the picture which you wish to place. You will be prompted with a place cursor. You 

can click anywhere on the page to place the picture. A picture box is automatically created 

and the picture file chosen is imported into the picture box.  

Import...   

This menu item is enabled either when you want to import either text or picture.  

Clicking this menu an import dialog is displayed, includes  File 

Name: you can enter the file name to import.  

List Files of type: Select the type of file to import.  
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Folders: Choose the appropriate directory where the file to be imported exists.  

Drives: Choose the appropriate drive.  

Import Text...  

To Import text, you have to be in the Text Edit Mode. Now the Import Text... menu item 

will be enabled. On clicking this menu item, a standard file open dialog will be displayed. 

Choose the name of the text file which you want to import in this document. Then click 

OK.  

  

Edit Mode  

To be able to go to text edit mode, first select the IBEAM tool.  

If you now move the mouse on top of a text box, then the cursor changes to DOTTED 

IBEAM cursor.  

On clicking the text box with this cursor, the cursor changes to SOLID IBEAM. Also the 

boundary of the text box will become black indicating the currently selected text chain.  

In this mode the ribbon, if visible, changes to Text Attributes mode.  

Import Picture...  

To import picture, you have to be in the Picture Edit Mode. Now go to choose the Import 

Picture menu item. You will be prompted with an Import Picture File dialog. Enter the 

filename of the picture that you wish to import and click on the OK button. Picture Edit 

Mode  

To be able to go to picture edit mode, first select the IBEAM tool.  

If you move the mouse on top of a picture box, then the cursor changes to DOTTED HAND 

cursor.  

On clicking the mouse on the picture box with the cursor, the cursor changes to HAND.  



  

  

  

  

SARDAR AZEEM  PICT ATD  9 | P a g e  

 

Azeem_aag2000@yahoo.com 03135879331 www.pictacademy.com 

Now you are in Picture Edit mode.  

You can import picture and crop pictures in this mode.  

In this mode, the ribbon is in picture edit mode. In this mode, you can scale the picture 

inside the picture box along the X and Y direction. You can also crop the picture along the 

X and Y direction.  

Export...  

Export Text: This menu item is enabled in Text Edit Mode. You will have to select the text 

to export. On choosing this menu item, you will be prompted with a Dialog which includes 

File Name: Enter the file name that you want the exported text to be saved in.  

List Files of type: Select the type of file to export.  

Folders: Choose the appropriate directory where the text to be exported.  

Drives: Choose the appropriate drive.  

Only the selected text will be exported. To export all text choose Select All (Ctrl-A) and 

then export.  

Export Picture:. This menu item is enabled when you are in Picture Edit Mode. Now 

you can convert the existing picture to one of the types specified in the Picture Export 

dialogs.  

File Name: Enter the file name that you want the exported picture to be saved in. List 

Files of type: Select the type of picture to export. The following export types are 

supported.GIF, JPEG,TGA, TIF, PCX, EPS, BMP  

Folders: Choose the appropriate directory where the picture to be exported.  

Drives: Choose the appropriate drive.  

Export Page…  
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Exports the page(s) of current document as picture(s). On selecting this menu item you will 

be prompted with a dialog where you can specify the following attributes— Filename: Lets 

you enter a suitable name for your exported graphics format file. The filename extension 

should indicate the graphics format you want the page(s) exported in.  

The supported graphic formats along with its extension is given below—  

.gif for GIF, .jpg for JPEG, .tga for TGA, .tif for TIF, .pcx for PCX, .eps for EPS, .bmp for 

Bitmaps.  

  

Export Range:  

All Pages : Lets you export all pages of your document. Each page is exported as a separate 

file. The filename is by concatenating filename with page number of the page being 

exported.  

Pages :Exports the specified page range. By default it exports the current page. Scaling: 

By default the page is exported with its exact dimensions. If you wish to change the size 

of the exported picture, specify the appropriate scaling percentage in this field.  

Print...  

  

On selecting the Print menu, the standard Print Dialog is displayed.  

Printer: You can specify a particular printer and set it attributes.  

  

Name: Select the desired printer from the names given in this combo box.  

Status:  

Print To File: If it is off then your print job will be sent directly to your local device.  

If this option is enable, You will be prompted for a filename.  
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Custom Post Script: This option can be selected if you want to use a custom post script 

printer.  

Properties: This button when clicked gets you to the printers setting dialog box based on 

the whether Custom Postscript Printer Option is checked or not.  

  

Incase the above option is checked then Options dialog box for customizing Postscript 

printer’s settings is displayed else the normal printer settings dialog box is displayed.  

  

Print Range: You can print specific pages, or a range of pages.  

All: Prints all pages if All radio buttons is checked.  

Pages From To: Type the range of pages with starting and ending numbers in From and To 

Box respectively.  

Print Sequence: Specify the printing page sequence of the document to be printed. It may be 

even, odd, or All. By default all pages will be printed.  

Print Style:  

Normal: When this button is checked the document will be printed as it is  

Auto Tiled: If your document page is so large that it exceeds the printable area of your 

printer and needs to be printed on more than one page, check Auto Tiled option. InPage 

will generate multiple pages that can later be assembled and pasted to form complete page. 

Manual Tiled: This Option is same as Auto Tiled option except here you can specify the 

overlapping of pages in Across/Down section.  

Registration Marks: Registration marks print at the four corners of your page. They tell the 

user where to trim the printed output.  
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Copies:  

Number of Copies: Specify the number of copies you need.  

Collate Copies: The collate option is only available when printing multiple copies of a 

multi-page document.  

Choosing Collate will cause one full set of selected pages to print before going on to the 

second full set. For example, a set of pages 1 to 20 will print, then second set of pages 1 to 

20, and so on.  

If do not enable collate, the requested no. of copies of each selected page will print before 

going on the next page. For example the printer will print ten copies of page 1, then ten 

copies if page 2, and so on.  

Scaling: You can change the value numerically (for an enlargement set a value greater than 

100%; for reduction, set a value less than 100%).  

Crop Marks:  

Registration Marks:  

After ensuring that the required printer is selected, click OK to proceed to Print. A Printing 

dialog with a Cancel button is displayed. This dialog updates number of pages which have 

already been printed. If you click the Cancel button, then the Printing is aborted. Printing 

through Postscript Printers  

For Postscript printers, from the Options dialog you can choose the Advanced options 

button. In this dialog box, you can either send True type fonts as postscript fonts or as 

Bitmap. For printing to printer without the downloaded fonts, you should select the Send 

True type as Type 1 option.  

If you want to print using already downloaded fonts, you should print through a printer 

driver which supports the following options. Adobe Default Printer driver or Acela-
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AWriter printer drivers are two such drivers. Within the True type font option set "Don't 

Send" TrueType fonts. Also within the Postscript option check the "Do not download fonts" 

checkbox. Now if you print, the postscript file which is sent to the printer does not have 

font information. It just has the names of the fonts, and the font information it picks up 

from the printer.  

Downloading fonts to the Printer Hard disk  

Look into your printer manual on initializing the printer hard disk and downloading the 

fonts to this hard disk. Usually there are lots of utilities which allow you to initialize the 

printer hard disk and download fonts.  

Postscript Printers(Setting Options)  

To verify the basic setup of Customized PostScript Printer, click Properties button in the 

Print dialog box. This will lead you to an Options dialog box in which you can set the 

various attributes.  

Paper Size: Here you can select the desired paper size out of the available paper sizes.  

Orientation: You can select any of the two choices(Landscape and Portrait). By default 

Portrait is the selected paper orientation.  

Print Quality: Most of the printer drivers generate output at different resolutions. The  

Print Quality Box lists the resolutions that are available for selected drivers Print 

as a Mirror Image:  

Download Characters:  

Color:  

Color Separation: The color separation process breaks down colors into their respective 

components or channels Frequency:  

Angle:  
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PPD File:  

Use PPD File:  

After ensuring that the required printer is selected, click OK to proceed to Print. If you click 

the Cancel button, then the Printing is aborted.  

Exit  

Choose Exit when you want to quit the application. If any of the open documents have not 

been saved, a message box prompts you to save the document.  

Edit Menu   

Edit Menu allows you to select one of the following menu items.  

Undo   

Undoes the previous operation. If previous operation cannot be undone then this item is 

disabled. This item will indicate the last operation which can be undone.  

Cut   

This command copies the selected object(s) or the selected text into the clipboard. It 

remains in the clipboard until you do a cut again. The selected object(s) or the selected text 

will be deleted from the document.  

To cut text, you will have to be in the Text Edit Mode. Select text which you want to cut. 

Now choose the Cut menu item from the Edit menu. The selected text will be removed 

from the Text Box and it will be placed in the clipboard. If you want to paste this text 

somewhere else, choose paste from the Edit menu.  

To cut a picture goes to Picture Edit Mode. Choosing Cut from the Edit menu will place the 

selected picture into the clipboard.  

http://inpageurdu.blogspot.com/2010/01/edit-menu.html
http://inpageurdu.blogspot.com/2010/01/edit-menu.html
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To cut object, you will first have to select the object or objects which you want to cut. Now 

choose the Cut menu item from the Edit menu. The selected object will be removed from 

the from the document and will be placed in the clipboard. Now you can paste this object or 

object(s) with the paste menu Copy   

Copy copies the selected text, the selected picture or the selected object(s) into the 

clipboard. Copy is similar to Cut but the difference is that Copy does not delete the selected 

text or selected object(s) from the document.  

Paste  

You can paste copied text or objects from the clipboard into the document.  

To paste text, you will have to be in the Edit Text mode. On selecting the paste menu item, 

text is pasted at the insertion point in the Text Box. If some text is already selected, then 

during paste that text is overwritten.  

To paste picture, ensure that you are in Picture Edit Mode. On selecting the Paste menu 

item, the clipboard picture is pasted onto the selected picture box.  

If there are objects selected into clipboard, then on choosing the Paste menu item from the 

Edit menu, the Paste cursor becomes visible. On clicking with this cursor at any point on 

the page, the objects from the pasteboard are copied at that point. Duplicate   

Duplicate duplicates the selected objects. On selecting this menu item, you will be 

prompted with a dialog.  

In this dialog you will be required to specify the number of rows and number of columns of 

duplicated object that you desire. You also need to specify the row and the column gap 

between the duplicated objects. Or you can just let the default values work and just press 

OK. All the duplicated objects along with the original objects will be selected at the end of 

this operation. Clear   
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Clear is equivalent to Delete. It does not affect the Clipboard in any way.  

Clear can be used for deleting selected text, selected picture or selected objects.  

Select All  
to select whole text or objects.  

Find & Replace...  

Find allows you to search for Text in Urdu and in English.  

Find Text: Enter the text to be searched for in the Find Text edit control.  

Replace With: Enter the text that will replace the word(s) found by the Find command.  

Replace and Find: This command will replace the current occurrence of the found text.  

It will also find and select the next occurrence of the same word(s).  

Replace All: This command is similar to Replace and Find except that it will replace all 

the occurrences of the found text in one go.  

From Beginning: If you want to start the search from beginning of the text chain then 

checks Find From Beginning option.  

Match Case: If you want to match occurrence of the specified text in different case then 

check Match Case option.  

Match Word: If you do not want to match occurrence of the specified text within a word 

then check Match Whole word option.  

Find Next: Click on Find Next button to start the search. If the text is found then the 

found text will be selected other wise the system will beep.  

Find Text: Enter the text to be searched for in the Find Text edit control.  
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Close: Find dialog stays on top of the text until you press Close.  

Top Most   

Sometimes in a double-sided document and with Facing Pages ON, you may need to draw 

an object which is common to both the pages. Even though this object occupies both the 

pages, it actually belongs to one particular page. When the objects of the other facing page 

are being drawn then this object usually gets drawn last. To enable some other object to be 

drawn after this big object, you can select that object and make it Topmost.  

Send To Back  

Sends the selected objects behind the unselected objects. Useful when at the same point 

here are more than one objects and you wish to work with the object which is below. For 

this first send to back the top object. Now the object which was earlier below comes on top.  

You can now carry out the desired operation on this object.  

Bring To Front  

Brings the selected objects in front of the unselected objects. Useful when at the same point 

there are more than one objects and you wish to work with the object which is below. For 

this first bring to front the object which is behind. Now the object which was earlier below 

comes on top. You can now carry out the desired operation on this object.  

Lock Guides  

This menu item enables you to lock guides. This prevents them from being accidentally 

modified. On selecting this menu item, it will appear checked. Now the guides are not 

modifiable by mouse. If you want the modify guides using the mouse, then uncheck this 

menu item by selecting it again. Story Editor  

This menu item enables you to switch between Story Editor and Page Layout mode. The 

story editor mode is useful for fast editing of story. All the text attributes except the font 
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size are displayed in a WYSIWYG fashion in this mode. The size of the text can be set in 

the Story Editor Preferences. To go back to Page Layout mode choose this menu item 

again.  

  

Delete Page...  

In the ensuing dialog, you can enter the range of pages to be deleted.  

From Page: Type the starting page no. to be deleted.  

To Page: Type the ending page no. to be deleted.  

You can remove all but one page in the document.  

For a double sided document, you have to delete pages in multiples of two except if the 

deletion range includes the last page in the document. Menu Edit: Preferences   

 allows you to set the Application, Document, Typographic, Story Editor and Nastaliq 

Entry Window Preferences. All these occur as submenus. Preferences: 

Application Preferences  

On selecting the Application Preferences, the Application Preferences dialog is displayed.  

Application Type:  

Left To Right/Right To Left: To change the overall working direction of the application. 

This can either be Left To Right as in English documents or Right to Left as in Arabic 

documents. Changing application to "Left To Right" will lead to change in the positions of 

the Tool Bar, the Rulers, the Scroll Bar and the Status Bar. Also the document is taken to 

flow from Right to Left i.e. all the measurements will be taken from right.  

Arrow Keys Movement: The selected objects can be moved with Arrow keys.  

With Control: You can specify the amount of the movement with the Arrow Keys as also 

movement if Control Key too pressed.  



  

  

  

  

SARDAR AZEEM  PICT ATD  19 | P a g e  

 

Azeem_aag2000@yahoo.com 03135879331 www.pictacademy.com 

Greek :  

Text Below: Greek Text Threshold limit. This value specifies the font size below which the 

text display will be greeked.  

Pictures: If this check box is on, then the picture is not drawn.  

Right Button:  

Floating Menu/Zoom: You can customize the behavior of the right button click. If you 

select Zoom, then you can zoom in/out directly as per the zoom percentage specified in 

Zoom % field. On the other hand choosing Floating menu enables you to select from a 

menu.  

Zoom %: The percentage amount to zoom in or zoom out when the user clicks on the right 

button.  

Guides Color: You can set the color of the three kinds of guides used in InPage.  

Margins ...: Page guides are the default guides which appear at the margins of the page. 

User ...: Other guides whom the user makes are the User guides. On clicking on the 

respective button, you are prompted with a dialog where you can choose the color you want 

to set.  

Column…: Column guides appear if the user specifies the number of columns in the New 

Document dialog or the Document Format dialog.  

Drag and Drop of Text: Selected InPage Text can be dragged and dropped from one text 

box to another text box or from one document to another document. Also textiles can be 

dragged and dropped into a text box.  

1. To enable drag and drop of text, you first need to go to application preferences and check 

the drag and drop Text check box ON.  

1. Now the text to be dropped is to be selected.  
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1. If you move cursor on top of this selected box, it will become an arrow tool. You can 

click on this selection the cursor will change to drag/drop cursor. Now you drag with mouse 

pressed and leave the text at the cursor position in this text box or some other text box in 

this or another InPage document.  

1. If you press Control key while dragging the mouse, then the text will be copied and not 

cut.  

Auto saves of InPage document: If you wish your current InPage document be 

automatically saved periodically then you can do so by checking on the Auto save button. 

The number of minutes after which the document should be saved can be entered in the 

editable field.  

Allow Custom Postscript: If you wish to generate custom Postscript then you can put the 

corresponding check box ON. This will enable a Custom Postscript check box in the Print 

dialog. For a Postscript driver, you can then generate Postscript file, which can then be used 

for color separation.  

Preferences: Document Preferences  

The Document Preferences allows you to do the following  

Measurement Unit:  

General/Character: Specify the Units for the General/Character measurements as Inches, 

Picas, Points, Centimeters, and Millimeters.  

Guides:  

Snap Distance: Enter the snap distance in points. This defines a region (based on the 

specified snap distance) around each guide. If an object is moved inside this region, the 

object will snap to the guide position.  
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Position: On selecting the Guides in Front, the guides are drawn in front of all other objects. 

New guides now constructed also appear on top of the existing objects. On selecting Guides 

Behind, all the guides are sent behind. The objects are drawn on top of the guides.  

Page Number:  

Start: Sets the starting page of the document. Default is 1. Useful during printing a part of 

the document.  

Style: Sets Page Number style that you want the page Number to appear in.  

Pasteboard Size: Across/Down: If you need to increase the Pasteboard size around the 

pages, then you can do so by entering the Horizontal and Vertical Pasteboard size values.  

These values can be entered either as percentage of the page size or as absolute values.  

Rulers:  

Visible: You can set as to whether in this document, the rulers should not be shown or not.  

Origin Across/Down: Specify the distance of Ruler Origin from Left. Top of the Page for 

Left to Right documents and from Right, Top of the Page for Right to Left documents. 

View: The View Percentage for the document can be set here. Another way to specify this 

is by entering this value in the Status Bar.  

Save As Default: Saves the current values in the Preferences dialog as application 

preferences so that the next time you make a new document, it automatically takes on these 

values.  

Defaults: This button restores the default values of all the fields in this dialog.  

Preferences: Typographic Preferences  

The Typographic Preferences allow you to change default values for text formatting. 

Nastaliq Space Width: Here you can set the width of the Nastaliq Space as a percentage of 

the font Size.  



  

  

  

  

SARDAR AZEEM  PICT ATD  22 | P a g e  

 

Azeem_aag2000@yahoo.com 03135879331 www.pictacademy.com 

Auto Line Spacing: Specifies the amount of Extra spacing to be added to the line when the 

text is in Horizontal direction. This value is specified in percentage.  

Reduce Latin Font size: Specifies the percentage reduction of Latin Font size in comparison 

to Urdu Font size. For Example if Urdu char if of 10 pt. Size then 10% reduction in Latin 

Font size means, the English char will appear of 9 Pt.  

Justification Priorities:  

Nastaliq Space: Specifies the space between Urdu/Arabic characters  

Latin Space: Specifies the space between English characters Box 

Styles:  

Above: Specifies the percent of font height by which to extend the top of boxed style above 

the top of the base characters.  

  

Below: Specifies the percent of font height by which to extend the bottom of boxed style 

below the bottom of the base characters.  

Text: Specifies the amount of spacing to be given between the boxed style and text before 

and after as percent of font height.  

Underline:  

Shift: Amount in Percent of font size of base character by which to shift underline down.  

Width: Thickness of underline in Percent of base character font size.  

Save As Default: Saves the current in the preferences dialog as Application preferences , So 

that next time you make a new document it automatically takes these values. Auto Kerning: 

This feature has been provided to automatically remove white space between nastaliq 

words. This allows the nastaliq text to look more compact. For version 1 files this check 

box is set to OFF to allow the same spacing for nastaliq text as in version 1.  
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For new documents, this checkbox is always ON.  

Auto Kashida: When you are justifying Arabic text, you have an option to allow InPage to 

automatically insert the Kashida character instead of inserting extra white space.  

Defaults: This button restores the default values of all the fields in this dialog.  

Preferences: Story Editor Preferences  

This menu item prompts you with a dialog in which you can set Story Editor Preferences.  

Story Font Size.  

Here you can set the Font Size in which the Story Editor will show the Text in.  

Print Font Size.  

You can set the Font Size fin which the story Editor will print out the Text.  

Preferences: Keyboard Preferences  

With this option you can either select one of the predefined keyboards (Aftab, Muqtadra, 

Phonetic, Farsi, Arabic) or make your own keyboards (up to eight User Defined Keyboards 

can be defined). Predefined Keyboards cannot be modified whereas you can modify User 

Defined Keyboard according to your need.  

Keyboard: You can specify your preference for a keyboard by selecting it from the Combo 

box and clicking on OK button.  

Enable Sindhi: if you want to use Sindhi then check this box.  

Enable Pushtu: if you want to use Pushtu then check this box.  

View/Edit: If you have selected one of the fixed keyboard, you can either view the 

keyboard layout and can also edit in the case of User Defined Keyboards  

To make a new user defined keyboard, you need to go to the Keyboard Preferences dialog 

in the Edit menu and follow these steps— · Select one of the eight User defined 

keyboards.  
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· Click on the User Defined keyboard button.  

· Select one of predefined keyboards from the Import Keyboard combobox.Your new 

keyboard will be based on this keyboard.  

Now you can make modifications to this keyboard by assigning a character to a key. To do 

this, click on the character and while keeping the mouse pressed dragging the mouse and 

leave it on top of the key where you wish to place this character.  

View Menu   

View menu lets you change the way the document is being viewed on the screen. The 

operations that you can carry out through this menu are  

Scale the entire document  

Hide/Show Ribbon, Rulers, Tools and Guides  

View the pages in the document either in Facing Pages or in Non Facing Pages mode.  

The various menu items that you can select are  

Fit In Window   

The complete visible portion of the document is scaled down to fit in the display window. 

Depending on whether you are in Facing Pages mode or Non Facing Pages mode, you will 

see one page or two pages scaled down to fit in the display window. All the objects on the 

page are also suitably scaled in the same ratio. You can carry out all the operations of 

drawing, selecting & editing objects and text in this and other scaled view modes.  

View:50%   

The complete visible portion of the document is scaled down by 50%. Thus the visible 

pages and the objects on these visible pages are all scaled by 50%.  

Actual  

Once you have scaled up or down the document, you can switch back to viewing the 

document in the normal way by selecting the Actual menu item. This is equivalent to 

saying that you are viewing the document in 100% scaled mode. View:200%  

Choosing 200% scales up the document view by 200%.  

Facing Pages  

In the Facing Pages Mode, two adjacent pages of the document are displayed side by side 

on the screen. Whereas in the none Facing pages mode, only one page is displayed at a 

time. Facing Pages Mode is usually used for double sided documents to view facing pages 

simultaneously. Also scrolling pages with the help of Page scroller scrolls two pages at a 

time.  

http://inpageurdu.blogspot.com/2010/01/view-menu.html
http://inpageurdu.blogspot.com/2010/01/view-menu.html
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This menu item lets you switch between the Facing and the Non Facing Pages mode. On 

selecting the menu item, a check mark is placed against this menu item indicating that you 

are in the Facing Pages Mode. On selecting this menu item again, the check mark 

disappears indicating the Non Facing Pages mode.  

Hide/Show Ribbon   

If you need more working space on the screen, you can hide the ribbon by selecting Hide 

Ribbon menu item. The ribbon will now be hidden and the document along with the rulers 

will shift up to occupy space created by the ribbon. The menu item will now change to 

Show Ribbon. Thus if later on you require the ribbon, you can select Show Ribbon to get 

back the ribbon.  

Hide/Show Tools   

If you need more working space on the screen, you can hide the tools by selecting Hide 

Tools menu item. The rulers and the document will shift to occupy space left by the tools.  

The menu item will change to Show Tools.  

To get back the tools, select the Show Tools menu item.  

Hide/Show Rulers  

To hide the horizontal and the vertical rulers, select the Hide Rulers menu item. The 

document will shift to left and to the top to occupy space left by the rulers. The menu item 

will change to Show Rulers.  

To get back the rulers, select the Show Rulers menu item.  

Hide/Show Guides  

To hide the guides, select the Hide Guides menu item. You now get the document view 

without guides. Text Box guides, Picture Box Guides, Page guides and Guides (constructed 

by you) are all hidden. The menu item text toggles between Show Guides and Hide Guides. 

Once you select the Hide Guides menu item, the menu item changes to Show Guides. To 

display the guides, select the Show Guides menu item. The menu item will now change 

back to Hide Guides. Hide/Show Invisibles  

Toggle display of Invisible characters. When invisibles are displayed following invisible 

characters are displayed with special markers space as . tab as arrow key . line end 

character as ¶  

Snap To Guides  

To snap objects to guides, select this menu item. A check mark against this menu item 

indicates that the objects created or moved will snap to guides as and when they are in the 

snap region as defined by the Snap Distance in the Preferences menu item. If you wish to 

disable snapping to guides then select this menu item again. This toggles the Snap to 

Guides menu item.  
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Format Menu   

The Format menu allows you to select one of the following menu items Character...  

This option lets you to specify character formatting attributes for selected text. Character 

format dialog is displayed with following items  

Size: Enter the desired font size in either points, millimeters, centimeters, or inches. Font 

size can also be chosen from the drop down list.  

Style: Choose one of following styles for the selected text.  

Single Underline  

Double Underline  

Overline  

Box  

Amikake  

Reverse  

Color: Color of The Text. You can choose from one of the document defined Colors.  

Bold/Italics: Selected text can be made Bold or Italics with this option.  

Latin Font Name: Choose the roman font for the selected text, InPage will apply this font 

to all roman text in the selected text.  

Arabic Font Name: Choose the Arabic font for the selected text, InPage will apply this 

font to all Arabic text in the selected text.  

Urdu Font Name: Choose the Arabic font for the selected text, InPage will apply this font 

to all Urdu text in the selected text.  

Language: You can change the language to English to facilitate entry of upper ASCII 

characters i.e. characters entered using Alt and Numeric keypad. Thus you can enter bullet 

marks, typographic dash etc.  

Spacing: Enter the spacing in percentage. Extra spacing will be introduced between the 

selected characters. The extra spacing amount can be specified in any of the standard 

distance units or as percent of font size.  

Scaling: Enter the percentage by which to scale the selected characters. 100% is default 

which implies no scaling. 200% scaling will double the character width and 50% will half 

the character width.  

http://inpageurdu.blogspot.com/2010/01/format-menu.html
http://inpageurdu.blogspot.com/2010/01/format-menu.html
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Baseline Shift: Enter Shift distance of the Selected Text from the baseline. This shift can 

be specified in any one of the standard distance units or as percent of font size.  

Paragraph  

This option lets you to specify paragraph formatting attributes for selected text. Paragraph 

Format dialog is displayed with following items.  

Alignment: Choose Left, Centered, Right ,Justified and Forced Justify Alignment styles for 

selected paragraphs.  

Indents:  

Beginning: This option sets the Indent amount at beginning of line for lines after the first 

line of selected paragraphs.  

End: This option sets the Indent amount at end of line for all lines in the selected 

paragraphs.  

First line: This option sets the Indent value for first lines of selected paragraph.  

Line Spacing:  

Line Height: This option decides height of each line in the selected paragraph. The value 

specified is the distance between the top of the line and bottom of the line. Text is drawn 

centered within this Spacing. If Auto is specified for this option then InPage automatically 

finds out the text height in the line and adds some percentage to the text height. This value 

is then used for Line Spacing. The extra percentage can be changed from the Preference 

option.  

Interline Gap: This option sets the gap between lines of the selected paragraphs.  

Tab:  

Default Stop: This option chooses the gap between default tab stops in the document. A tab 

character tabs to the next default tab position if no tabs are specified after the tab character.  

Breaks: Selecting Page Break from the Breaks combo box takes the current paragraph to 

the beginning of the next page.  

Selecting Column Break inserts a column break for the current paragraph. This takes the 

current paragraph to the beginning of the next column.  

Keep Together: Check this option to disallow splitting of selected paragraphs across 

columns or frames.  

Keep With Next: Check this option to disallow next paragraph to be in different frame of 

column.  

Window: Enter number of lines at top of paragraph after which the selected paragraphs can 

break across columns and frames  

Orphan: Select number of lines at end of paragraph where the paragraph is not allowed to 

break.  

Paragraph Spacing:   

Before: This option sets the space before the paragraph. This spacing will not be applied to 

paragraphs at top of Box.  

After: This option sets the space after the paragraph. This spacing will not be applied for 

paragraphs ending at Box bottom.  
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Character Alignment: You can align the Latin/Arabic text either on the baseline in which 

case you should select the baseline character alignment option. If you wish to center align 

the text by choosing the Center Align option.  

Add To Table of Contents: You can add the selected paragraph as a table of content entry.  

Hyphenation  

This menu item enables you to control hyphenation in Roman Text.  

These options are  

You can specify as to the hyphenation being light or heavy.  

The maximum number of consecutive hyphenated lines.  

Menu Format: Borders  

This option allows you to specify Border attributes for Selected Paragraphs. Options allow 

you to specify Border Before or After, Border Type, Border Thickness and Color. In the 

Border Type combo box choose from None, Indents and text options. Indents option will 

create a border from beginning indent to end indent of the paragraph. Text option will 

create a border from beginning of first character of the line to last character of the line. 

Clicking on Style Button displays the Border formatting dialog. Through this dialog you 

can specify the Thickness of the border line and the color of the border. Save as default 

button in Border Style Dialog saves the current settings of the border as application 

defaults.  

Tabs  

This option allows you to set tab positions and tab attributes for the selected paragraphs. By 

choosing Tabs option from Format menu you enter into Tabs Setting mode of InPage. In 

this mode the selected text will be highlighted as a box  

To Create a new Tab position click on the highlighted text. This will create a tab stop at the 

position you clicked and this will be displayed as a vertical bar.  

To Modify a existing Tab drag the vertical bar.  

To Delete an existing Tab drag the vertical bar out of highlighted text.  

To change Tab attributes like alignment select the Tab by clicking on the vertical bar. From 

the Tab Ribbon you can also set Indents for the selected text.  

Then choose the attribute from the ribbon. All attributes are explained below.  

1. Current position of vertical bar.  

2. Choose the Tab Leader.  

3. Set the default tab position.  

4. Set the first line indent.  

5. Set the right tab position.  

6. Switch back to text edit mode. Or press Escape  

7. Click any one of the tab.  

8. Remove all tabs.  

9. Set the left tab.  

Text Wrap  
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This option enables or disables the text wrap feature for the currently selected text chain. If 

the text wrap is off for a text chain then the text in that chain will not wrap around 

overlapping objects. If the option is on then the text in that chain will wrap around 

overlapping objects with Text Runaround attribute checked.  

Sort Text  

This option enables or disables the text wrap feature for the currently selected text chain. If 

the text wrap is off for a text chain then the text in that chain will not wrap around 

overlapping objects. If the option is on then the text in that chain will wrap around 

overlapping objects with Text Runaround attribute checked.  

Table Format  

This dialog enables you to format the table in terms of Cell Width, Cell Fill Color, Cell 

Border and Indents within the Cell.  

Cell:   

Fill Color: You can select the cells of the table and specify their fill color. The fill color 

gets applied to the selected cells.  

Border: You can specify the border of all cells in the currently selected table as follows. 

Color: Allows you to select the color of the border from the list of colors combo box.  

Style: Style of the border in terms of document wide line patterns Solid, Dotted, Dashed, etc.  

Width: Thickness of the border line.  

Cell Order:  

Left To Right: Click this option if you wish to keep the flow of text from Left To Right. 

Right to Left: Click this option if you wish to keep the flow of text from Right To Left.  

Column:   

Width and Gap: This allows you to modify column widths of the selected columns.  

Table:  

Indents: You can specify the amount of indent within the Cell.  

Alignment: Choose the text alignment within the cell is on the Left, Right or Centered.  

Table Layout  

The Table Layout dialog allows you to carry out the following operations Row: 

Allows you to insert/delete a row before or after the current row.  

Column: Allows you to insert/delete a column before or after the currently selected 

column.  

Split or Merge Cells: Merges the currently selected cells of the table. For cells merged 

with the previous merge command, this command enables you to split the cell.  

Object  

Lets you to format the selected objected. On clicking this a Dialog will be displayed with 

following options Bounds:  

Across/Down: Contains the Object Origin Across and Origin Down. To move the object, 

modify these values. To do this, click with mouse on the Origin Across field and enter new 

value. Now either press the Tab Key or again click the Origin Down field with the mouse. 

Press enter/return after entering the new value. The Object will now shift to the new origin. 
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If more than one object is selected then these fields get grayed and you cannot enter into 

these fields.  

  

Width/Height: Displays the object's width and height. To resize the Object, edit these 

values by clicking the mouse on Width field and entering the new width, and/or by clicking 

the Height field and entering the new height. The Object will now be resized.  

These following four attributes is for only Picture and Graphic Boxes.  

Picture:   

Origin: Specify the Left/Top position of picture in Across/Down Section.  

Scaling: Scales the picture.  

Across: If you want to increase/decrease the width of picture, then enter the no. more than 

100 or less than 100 respectively.  

Down: If you want to increase/decrease the height of picture, then enter the no. more than 

100 or less than 100 respectively.  

Shape:   

Fill: Usually the object is filled with white color. This is the background against which the 

text/picture appears. To apply some other background color, choose from the list in the Fill 

Color Combo Box.  

Rectangular/Rounded Rectangular/Elliptical : Three Icons/radio buttons representing 

the three different kinds of boxes(  

Rectangular, Rounded Rectangular, and Elliptical) are displayed. The selected icon/radio 

button represents the type of the selected picture or graphic box. To change the box type, 

click on one of the other two Icons/radio buttons.  

Roundness: For the Rounded Rectangular Box, the amount of roundness can be specified 

horizontally and vertically.  

When you select the text box then the following two attributes will be shown. Columns 

and Gutter : This attribute is applicable only for a Text Box. A Text box is usually 

created with one column. To change number of columns, enter the number of columns 

in the columns field. The gap between two columns (Gutter Size) can also be modified.  

Background:  

Color: Usually the object is filled with white color. This is the background against which 

the text/picture appears. To apply some other background color, choose from the list in the 

Fill Color Combo Box.  

Hatch: if you want background with some hatch pattern then select the appropriate pattern. 

By Default no Hatch Pattern will be selected.  

Border :  

Color/Width/Pattern: To apply a border to the Object Box, enter the border width in 

points. You can also change the color by selecting the color from the Border color combo 

box (Default is Black). the Pattern can be one of the Document wide Patterns like Solid, 

Dotted, and Dashed etc.  
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Inside/Outside: If Object Box border is drawn inside the object, the actual bounds for the 

text/picture will become smaller on all four sides. To keep the text/picture bounds constant, 

you will have to select the Border Outside Icon.  

Runaround: You can disable or enable Runaround for the selected objects by unchecking 

or checking this check box.  

Template: You can mark an object as a template object, in which case, when you drag the 

object then a copy of the template object is peeled off. This option enables you to make 

precise copies of template objects and place them as per your requirements.  

Lock: If the object is marked locked, then the object can neither be deleted nor modified by 

using the mouse. To delete the object, you will first have to unlock it. Copies of Master 

objects appear as locked by default.  

Don’t Print: This check box enables you to disable printing for the selected objects by 

checking this check box on for these objects. Runaround  

In this dialog you can set the Runaround values along the four sides of the selected objects. 

Whenever this object overlaps a textbox, the text will flow around this object and will 

appear at the specified distances from this object's boundary.  

Run Around: if you require Runaround around box, then check this option.  

Inset  

This dialog allows you to specify the inset values for Text box. The text in the selected 

Textbox will always be inset by the specified values.  

Inset With Only With Graphic Frame: Check this option if you want to apply the inset value 

with only graphic frame.  

Master Page Objects...  

Allows you to format all master page objects on the specified range of pages.  

From Page/To Page: Enter the Page range to be formatted.  

Hide Objects of Master Page: If you choose option then all master page objects on the page 

range will be hidden.  

Show Objects of Master Page: will show the master page objects on the range of pages if 

they were previously hidden or deleted.  

Restore Objects from Master Page: will remove any modifications made to the master 

page objects and make them exactly same as they are on Master Page. As mentioned 

previously the objects of master page on a Page can be modified on the page. Master 

Page Objects...  

Allows you to format all master page objects on the specified range of pages.  

From Page/To Page: Enter the Page range to be formatted.  

Hide Objects of Master Page: If you choose option then all master page objects on the page 

range will be hidden.  

Show Objects of Master Page: will show the master page objects on the range of pages if 

they were previously hidden or deleted.  

Restore Objects from Master Page: will remove any modifications made to the master page 

objects and make them exactly same as they are on Master Page. As mentioned previously 

the objects of master page on a Page can be modified on the page.  
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Document Setup...  

Similar to the New menu item in the File menu. It allows for setting up of document pages 

in terms of their sizes, orientations and margins.  

See New menu Item from File Menu.  

Displays a dialog where you can enter values for your new document. The attributes that 

can be set in this dialog are-  

Page: You can select one of the standard pages sizes from the Page Size combo box. 

Width/Height: If a custom size is desired, then you need to enter the Page Width and Page 

Height.  

  

Orientation:   

Portrait/Landscape: The pages in the document can either be in a Portrait mode or in a 

Landscape mode. In Portrait mode, the width and height that you specify are taken as such.  

Whereas in the Landscape mode, the widths and heights are interchanged.  

Pages: Specify here number of pages in the document with which you want to start your 

new document. If the Automatic Text Box check box is checked then the Text Boxes will 

appear on all these pages. You can later on choose Insert Pages menu option to add more 

pages.  

Margins: Specify the page margins as distances from the respective page boundary. At 

these positions page margin guides will be drawn and if a automatic Text Box check box 

(described later in this dialog) is checked on, then the new Text Box will lie along the 

margins.  

Direction: Specify the direction of text entered.  

Left To Right: Check this option if you wish to have the text direction from Left to Right.  

Right To Left: Check this option if you wish to have the text direction from Right to Left. 

Columns: Specifies numbers of columns in the document. The number of columns in the 

document can later on be modified using Format Document menu option.  

Gutter: Specify the gap between columns.  

Automatic Text Box: If this option is checked then an automatic text chain appears on all 

the pages of your document. Thus you do not need to draw and link Text Boxes afresh. 

These Text Boxes are all linked in a text chain, so that text flows from one Text Box on a 

page to another Text Box on next page.  

Double Sided: If this option is checked, then your document will be double sided. You thus 

get two master pages, left master page and right master page. In a single sided document, 

you get only one master page which is applied to all the pages in the document. Facing 

Pages: If this option is checked then you can view the pages in your document in Facing 

Pages Mode. In facing pages, two pages are displayed at a time, with both pages displayed 

side by side. Whereas in non Facing pages, one page is displayed at a time. Save As 

Default: The Save As Default button saves the current values in the New dialog as 

application preferences so that the next time you make a new document, it automatically 

takes on these values.  

Guides...  



  

  

  

  

SARDAR AZEEM  PICT ATD  33 | P a g e  

 

Azeem_aag2000@yahoo.com 03135879331 www.pictacademy.com 

You can view all the guides in the currently selected page. Vertical and Horizontal guides 

are displayed separately as lists.  

Vertical and Horizontal guides:  

Add: You can edit the guide positions by selecting the guide from the list and after 

modifying its value, clicking on the Add button.  

Modify: You can edit the guide positions by selecting the guide from the list and after 

modifying its value, clicking on the Modify button.  

Remove: You can remove a guide by first selecting it from the list and clicking on the 

Remove button.  

Grid: You can construct Grid of Guides by clicking on the Grid button. You will be 

prompted with the Grid dialog box. See Also Format: Grid....  

Define Grid  

You can construct Grid of Guides by entering the gap between the Vertical guides and also 

between the Horizontal guides. By default, the guides are created out. This Grid dialog will 

overwrite the existing guides if any in the vertical and the horizontal guides list. If you don't 

want this to happen, click on the Remove Existing Guides check button.  

Now click on the OK button. The newly made guides appear on the current page in the 

document. Style Sheets  

You can define your custom Style Sheets by selecting this menu item. A Define Style 

Sheets dialog is displayed. A list of Style Sheets with their names is displayed. You can 

now edit this list by either adding, removing or modifying an item from the list. New: To 

add a new Style Sheet, click on the New button. This prompts you to enter the name of 

the Style Sheet and brings up the Style Sheet modification dialog. In the based on field 

you can define which the base Style Sheet for the new Style Sheet. What ever attributes 

are not defined for this style will be picked from the base Style Sheet. The Paragraph, 

Character, Borders and Hyphenation definition buttons enable you to define or modify 

Paragraph, Character, Border and Hyphenation attributes for the Style Sheet. Remove: To 

remove a Style Sheet, select the Style Sheet to be deleted from the List of Style Sheets 

and click on the remove button.  

Modify: To modify a Style Sheet, select a Style Sheet from the List of Style Sheets. On 

clicking the modify button, the Style Sheet modification dialog is displayed. You can now 

modify the character and paragraph settings of the Style Sheet. The Paragraph, Character, 

Borders and Hyphenation definition buttons enable you to define or modify paragraph, 

character , border and Hyphenation attributes for the Style Sheet.  

Define Colors...  

You can define your custom colors by selecting this menu item. A Define Colors dialog is 

displayed. A list of colors with their names is displayed. You can now edit this list by either 

adding, removing or modifying an item from the list.  

Add: To add a new color, click on the New button. This displays another dialog called 

Color Settings. Here you can define a new color by specifying the Red Green Blue (RGB) 

values. Each of these values range between 0-255. After having specified the RGB values, 

enter the color name under which you want this color referenced for your use. Now click 
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OK button. This newly defined color gets inserted into the List of Colors dialog. This color 

also appears in all the combo boxes in all the ribbon.  

Remove: To remove a color, select the color to be deleted from the List of Colors dialog 

and click on the Remove button.  

Modify: To modify a color, select a color from the List of Colors dialog. On clicking the 

modify button, the Color Settings dialog is displayed. You can now modify the earlier RGB 

values along with the color name. On clicking the OK button, the modified color name and 

its value get updated in the List of Colors dialog.  

Insert Menu   

The items that you can select are  

Page  

You can add pages to your document by selecting the pages menu item. An Insert page 

dialog is displayed.  

Number of Pages: Enter the no. of pages to be added. If your document is double sided, 

then you can insert pages in multiples of two pages. Thus you cannot insert odd number of 

pages for a double sided document.  

Page Number  

Selecting this option inserts a page number field at the insertion point. This option is 

available only if insertion point is in Title Text Box. The page number field will display "#" 

character on the master pages and the appropriate page number on the document pages.  

Date and Time  

Selecting this option inserts a page number field at the insertion point. This option is 

available only if insertion point is in Title Text Box. The page number field will display "#" 

character on the master pages and the appropriate page number on the document pages.  

  

Picture  

Selecting this option inserts a Picture Box at the current text insertion point. Once you 

choose this option, you will be shown an Insert Picture dialog. Choose the picture file that 

you want to insert in the text. The chosen picture is inserted at the current insertion point. 

This picture can now be formatted like the pictures created using picture tool. You can 

select the picture and the selection points will become visible. You can choose these 

individual selection points and resize the picture. Table  

If you want to insert table at the current insertion point in the Text, choose this menu item.  

You will be prompted with a Insert Table dialog. Here you can specify  

Rows: Enter Number of Rows To Insert  

Columns: Type Number of Columns To Insert  

Column Width: The default is Auto in which case the width is automatically calculated 

based on the text box width available at that point.  

Text to Table  

http://inpageurdu.blogspot.com/2010/01/insert-menu.html
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If you have already selected text, then this menu item appears as Text To Table. On 

selecting this menu item, the selected text is converted to table as follows.  

The selected Paragraph is converted into a table with the text in the selected paragraphs 

moving to cells of the newly converted table. The number of paragraphs decide the number 

of Rows in the table whereas the number of columns in the newly created table is calculated 

on the basis of maximum number of tabs in selected paragraphs.  

Table to Text  

If the caret is inside the table or the table is selected then this menu item appears as Table 

To Text. On selecting this menu item the table is converted to text as follows.  

The selected Table is converted into Text. Each row gets converted into a paragraph. The 

text in each cell of the row gets separated by tabs.  

  

  

  

Split Table  

This command allows you to split the table at the current caret position. A useful function 

of this command is when the table is at the initial position in the text chain. This command 

allows you to shift the table at the first base line.  

Index Entry  

An index entry is composed of two parts : a topic and a reference. In addition the topic you 

may have sub topic. When you define an index entry, InPage inserts an index marker in the 

text to indicate that an index entry exists. Index markers are visible when you have Show 

Invisibles ON in the View menu. When you generate an index, InPage scans the document 

and looks for these index entries, alphabetizes index entries and creates an index on the 

clipboard. This can be pasted any where in the document.  

Although index markers move as text is added or deleted, the text before or after a marker 

is not connected to the index marker.  

In the current text chain, select the word (or set of words) that you wish to define as an 

index entry and then chose this menu item. You will be prompted with the Index Entry 

dialog box with the selected entry getting displayed in the Main Entry.  

If you wish to index only this occurrence of the selected word then click on the Mark 

button. On the other hand if you wish to index all occurrences of this word in the document 

then click on the Mark All button.  

You can also attach a sub topic to this index by entering the sub topic in the Sub Topic edit 

box.  

Utilities Menu   

Selecting the Utilities Menu allows you to select one of the following menu items Spelling  

Displays a Spell Check dialog which helps you in correcting the spelling interactively. Use 

this dialog box to check spelling in the current text chain or all the chains in the entire 

http://inpageurdu.blogspot.com/2010/01/utilities-menu.html
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document. InPage searches the online Urdu/English dictionaries for each word of your 

document, highlighting words not found in the dictionary. InPage scrolls the document so 

that the selected word is always visible to you to allow you to change the word. If the 

Spelling dialog obscures a word then you can move the dialog and place it anywhere else in 

the window. You can leave this dialog active while you work and bring it to the front when 

spell checking is required. For this you will have to click on Resume button to resume 

spelling check.  

If you are working in Text Editing mode (i.e. with I Beam Tool) then the Spelling dialog 

will check for spellings only in the current text chain. If however you are working with 

Arrow tool, then Spelling dialog checks for spelling in the entire document.  

· Change To In this edit box, InPage displays each word that it does not recognize. Type 

the correction here or select the correct word from the list of suggestions. To finally change 

the word click on the Change button.  

· Change button allows you to change the spelling of the selected word in the document to 

the spelling in the Change To edit box.  

· Ignore button ignores the word (i.e. leaves it as it is without changing it) and continues 

searching.  

· Change All is same as change button. Besides the selected word all occurrences of the 

word is replaced by the text in the Change To edit box.  

· Ignore All is same as Ignore. Besides this occurrence all occurrences of the word in the 

text chain or document are ignored and never come up again.  

· Add button adds this occurrence of the word to a user created dictionary.  

· Suggest button suggests various alternate words for a word in the Change To edit box.  

Word Count  

This displays the Word Count dialog which then displays the number of characters/words in 

the current text chain.  

Group  

This command allows you to group selected objects as one object. This enables you to carry 

out various format object operations on them simultaneously. Ungroup  

This command undoes the effect of the Group operation..  

Generate Index  

InPage provides powerful tools to help you create indexes. Creation of Index is a two step 

process.  

In step 1, you mark an  

Menu Insert: Index Entry  

An index entry is composed of two parts : a topic and a reference. In addition the topic you 

may have sub topic. When you define an index entry, InPage inserts an index marker in the 

text to indicate that an index entry exists. Index markers are visible when you have Show 

Invisibles ON in the View menu. When you generate an index, InPage scans the document 

and looks for these index entries, alphabetizes index entries and creates an index on the 

clipboard. This can be pasted any where in the document.  
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Although index markers move as text is added or deleted, the text before or after a marker 

is not connected to the index marker.  

In the current text chain, select the word (or set of words) that you wish to define as an 

index entry and then chose this menu item. You will be prompted with the Index Entry 

dialog box with the selected entry getting displayed in the Main Entry.  

If you wish to index only this occurrence of the selected word then click on the Mark 

button. On the other hand if you wish to index all occurrences of this word in the document 

then click on the Mark All button.  

You can also attach a sub topic to this index by entering the sub topic in the Sub Topic edit 

box.  

In step 2, you generate indexes. Generating 

Index  

Once you have inserted all the index entries, it is time now to generate the actual index. To 

do this select the Generate Index menu item from the Utilities menu. Please note that the 

generated index is copied onto the clipboard and so if you have some data on the clipboard 

which you wish to retain you should not continue with the generation of index.  

Once the generation is complete, the generated index is copied onto the clipboard. You can 

now paste this index anywhere in the document.  

Auto Index  

You can also enter all the indices in a text file and when you choose Auto Index menu item 

in the Utilities menu, it will prompt you with the Auto Index File Name. Once you choose 

the file, it will pick the index entries from the text file and generate the index as above.  

  

Table of Contents  

Generating Table of Contents like Index is a two step process.  

In step 1, you mark various Table of Contents entries.  

In step 2, you generate Table of Contents.  

To mark Table of Contents entries, you will need to use the Format Paragraph command 

and in the dialog click on the Add To Table of Contents check box. Thus checking on this 

check box adds the selected Paragraph as a Table of Content entry .  

Once you have marked all the requisites Table of Contents entries, you will need to 

generate the actual Table of Contents by using the Table of Contents menu item under 

Utilities menu. This will generate the Table of Contents and copy the generated index onto 

the clipboard.  

Edit Links  

This command allows you to change links/locations of the embedded image files.  

Symbol Menu   

Because not all special can be accommodated on the limited number of keys on the 

keyboard hence a library of these special symbols are supplied along with InPage which 

http://inpageurdu.blogspot.com/2010/01/symbol-menu.html
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then can be inserted by the user at the appropriate place in his document, by selecting them 

from this symbol menu.  

Window Menu   

The Window menu forms part of the standard Multi Document Interface(MDI). This menu 

item lets you move amongst the documents opened in InPage. You can select one of the 

following menu items Cascade  

Cascades the documents, so that the caption bars of all documents is visible.  

Tile  

All documents are visible at once and the documents window do not overlap one another. 

All the documents are given equal space on the screen. This is useful if you want to 

compare the contents of two or more documents.  

Close All  

Choosing this menu item closes all the open documents. If any document is modified and 

has not been saved, then you will be asked to save the modified document.  

Ribbon  

This menu item takes you to the ribbon. The editable item with which you last worked gets 

the focus. The caret will start blinking in that editable item. You can modify the value of 

this editable item and clicking on Tab takes you to the next editable item in the ribbon. 

When you have completed modification, press return to get back to the document.  

Page  

This menu item takes you to the Page Window in the Status Bar. You can enter the new 

page to go to by entering the page number and pressing Return or Enter.  

  

View  

This menu item takes you to the View Window in the Status Bar. You scale the document 

by entering the new value in the window.  

At the end in the Windows menu, you can see the list of opened document files. You can 

select one of the opened documents from this menu to work on that document.  

  

  

http://inpageurdu.blogspot.com/2010/01/window-menu.html
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 Help Menu    

Help Menu provides you an online Help facility. You can either view the Index or see the 

various Short Cuts. You can select one of the following menu items.  

Text Formatting Short Cut Keys,   
Bold  Ctrl+B  

Italics  Ctrl+I  

Left Alignment  Ctrl+Alt+L  

Right Alignment  Ctrl+Alt+R  

Center Alignment  Ctrl+Alt+C  

Justified  Ctrl+Alt+J  

Full Justified  Ctrl+Alt+F  

Toggle Text and Tab Modes  Ctrl+Alt+T  

Define Style Sheets  Ctrl+T  

Character Format  Ctrl+H  

Paragraph Format  Ctrl+G  

Increase Character Spacing  Ctrl+F5  

Decrease Character Spacing  Ctrl+F6  

Baseline Shift Up  Ctrl+F7  

Baseline Shift Down  Ctrl+F8  

Decrease Font Size  Ctrl+F9  

Increase Font Size  Ctrl+F10  

Page Movement Short Cut Keys,   
Scroll Page Up   Page Up  

Scroll Page Down   Page Down  

Scroll Page Left   Ctrl+Page Up  

Scroll Page Right   Ctrl+Page Down  

Scroll Page Up by One Line   Shift+Page Up  

Scroll Page Down by One Line   Shift+Page Down  

Scroll Page Left by One Line   Ctrl+Shift+Page Up  

Scroll Page Right by One Line   Ctrl+Shift+Page Down  

Page Change Short Cut Keys,   
Previous Page   Alt+Page Up  

http://inpageurdu.blogspot.com/2010/01/help-menu.html
http://inpageurdu.blogspot.com/2010/01/help-menu.html
http://inpageurdu.blogspot.com/2010/01/text-formatting-short-cut-keys.html
http://inpageurdu.blogspot.com/2010/01/text-formatting-short-cut-keys.html
http://inpageurdu.blogspot.com/2010/01/page-movement-short-cut-keys.html
http://inpageurdu.blogspot.com/2010/01/page-movement-short-cut-keys.html
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Next Page   Alt+Page Down  

First Page   Alt+Home  

Last Page   Alt+End  

Toggle Master and Document pages   Alt+Enter  

Page Editing Short Cut Keys,   

Alt Del   Delete Pages  

Alt   INS   

Selected Object Modification Short Cut Keys,   
Select All Objects   Ctrl+A  

Select/Deselect Multiple Objects   Shift+Mouse Click  

Delete   Del  

Cut   Ctrl+X  

Copy   Ctrl+C  

Paste   Ctrl+V  

Undo Previous Operation   Alt+Backspace, Ctrl+Z  

Move Selected Objects   Arrow Keys  

Smaller Movement   Ctrl+Arrow Keys  

Move Selection Point   Arrow Keys with mouse down   

Smaller Movement of Objects   Ctrl+Arrow Keys with mouse   

Constrain Movement  Shift while moving objects  

Move Objects to Original Position   Escape while moving Objects  

Make Object to Square or Circle   Shift while modifying an Object  

Make Line at any angle   Shift while modifying a line  

View Change Short Cut Keys,   
Fit in Window   F5  

50%   F6  

Actual   F7  

200%   F8  

Zoom In   Right Button Click  

Zoom Out   Shift+Right Button Click  

  

Pict abbottabad  

http://inpageurdu.blogspot.com/2010/01/page-editing-short-cut-keys.html
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Miscellaneous Short Keys   
Help   F1  

Snap To Guides   F9  

Typographic Preferences   F11  

Application Preferences   Alt+F11  

Document Preferences   Ctrl+F11  

Go to the Last Edited item in Ribbon   F12  

Go to the Page Scroller in Status Bar   Alt+F12  

Go to the View in Status Bar   Ctrl+F12  

Abort Current Import of Text   Escape  

Exit   Alt+F4  

Tab within a Table Cell  Ctrl+Tab  

Application Preferences  Double Click On Tool Strip  

Typographic Preferences  Double Click On Text Ribbon  

Format Guides  Double Click On Rulers  

Reset Ruler Origin  Double Click On Origin Box  

Page Scroll  Ctrl+Left Button Click  

Create Object with handles  Double Click on the Tool  

Open Files from File Manager  Drag Drop InPage File  

Import Picture from File Manager  Drag Drop Picture File  

Import Text from File Manager  Drag Drop Text File  

Toggle English/Urdu Entry   

You can toggle between English and Urdu by pressing Ctrl-Space. Also you can choose the 

menu item Toggle Language from the Language menu. If you have enabled Sindhi and 

Pushtu, then this command switches amongst English, Urdu, Sindhi and Pushtu.  

  

Corresponding to the current language its name is displayed in the task bar on the bottom 

right corner of InPage frame window.  

Using Corel Draw With InPage   

With Inpage, you can now enter text in urdu, copy the text box and paste it in Corel Draw  

5.0. The various steps are—  

  

1. First run InPage.  

http://inpageurdu.blogspot.com/2010/01/miscellaneous_15.html
http://inpageurdu.blogspot.com/2010/01/miscellaneous_15.html
http://inpageurdu.blogspot.com/2010/01/toggle-englishurdu-entry.html
http://inpageurdu.blogspot.com/2010/01/toggle-englishurdu-entry.html
http://inpageurdu.blogspot.com/2010/01/using-corel-draw-with-inpage.html
http://inpageurdu.blogspot.com/2010/01/using-corel-draw-with-inpage.html
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2. Now launch Corel Draw.  

3. Make a headline in InPage by first creating a text box or a title text box and  

    entering  urdu in the text box.  

4. Once the text has been completely entered, select the Arrow Tool from the tool        strip 

and now select this text box in the arrow mode.  

5. Copy this text box onto the clipboard by using the Copy command.  

    Now switch to Corel Draw and paste the text box you have already copied onto       

the clipboard.  

6. Go to the Arrange menu and choose Ungroup.  

7. Sometimes a text box appears as a frame when you paste the text in Corel Draw.     After 

ungrouping, you can select the frame and delete the extra frame.  

8. Now select the complete text using the selection rectangle and choose Combine     menu 

item from the Arrange menu.  

Note: If you wish to apply inter character scaling and/or inter character spacing, you should 

not do so in Inpage. Rather once the text has been pasted in Corel Draw, these effects 

should be applied from Corel Draw itself.  

How To Layout A Ghazal?   

Ghazals have a special place in urdu literature. There are essentially two ways to layout a 

ghazal. Ghazal Style 1  

To set the ghazal in this fashion, please follow these steps—  

1. Insert a Table with three columns. The extreme left and extreme right columns are 

to be used for entering ghazal text. The middle column will be used for controlling space 

between the text.  

2. Set the table width of the extreme right column (column no. 1) and extreme left 

(column no. 3) to 3 cm. Set the middle column to 0.2 cm. Set the Table Alignment to 

Centered. All these operations are to be carried from Format Table menu item in Format 

menu. 3. Select all the columns and click on the Forced Justify icon from the Text Ribbon.  

4. Now enter urdu text in column no. 1. Follow it up with two tabs to reach column no. 3 

and enter the corresponding second part of the couplet.  

5. Continue till you have entered all the four lines.  

6. For the bottom portion of the ghazal, enter one column table and specify the      width as   

3 cm. Again select the column and set the Forced Justify option.  

7. Now enter urdu text for the bottom portion of the ghazal.  

8. Repeat the above steps till you have laid out the complete ghazal.  

  

http://inpageurdu.blogspot.com/2010/01/how-to-layout-ghazal.html
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Ghazal Style 2  

  

To set this style of ghazal, you will need to use style sheet functionality. Follow these 

underlined steps—  

1. Create a style sheet by choosing the Style sheet menu item from the Format menu     

and clicking on the New button in the ensuing Style sheet dialog.  

2. Enter the name of the new style sheet as lets say 'Right' and click on OK button.  

3. Now click on the Paragraph button and specify the beginning indent (from left)   

    as 5cm and end indent (from right) as 2 cm. Also choose the Alignment as      

Forced   Justify.  

4. Enter the keyboard shortcut for the style sheet as 'R'.  

5. Make another style sheet and call it 'Left' with keyboard shortcut as 'L'.  

6. Specify the beginning indent as 2 cm and end indent as 5 cm.  

7. Once you have these style sheets, you can use Ctrl+Shift+R and Ctrl+Shift+L to     

apply the style sheet to the current paragraphs.  

8. First apply Ctrl+Shift+R and enter first two lines of urdu text.  

9. Now apply Ctrl+Shift+L and enter next two lines of urdu text.  

10. Repeat the last two steps till you have entered the complete ghazal.  

How To Layout An Urdu-English Dictionary?   

Supposing you need to create an Urdu to English dictionary (or for that matter English to 

Arabic dictionary), like follows—  

As you will notice that urdu text and English text appear in the same line and yet urdu is 

right to left and English appears left to right. The above has been created as follows— 1. 

Insert Table by using the Table menu item in the Insert menu.  

2. Specify number of columns (2 in this case) required along with its width if any. If you do 

not specify the width of the column, the text box width will be divided by number of 

columns required and you will get the default column width.  

3. Select the right column & click on Arabic character alignment button.  

4. Select the left column & click on the Latin character alignment button.  

5. Now start in urdu entry mode and enter urdu text. Once the text has been entered in a 

cell, press Tab.  

6. In this cell switch to English entry mode and enter the English text.  

7. Repeat the above steps to completely enter all the urdu and English text.  

  

http://inpageurdu.blogspot.com/2010/01/how-to-layout-urdu-english-dictionary.html
http://inpageurdu.blogspot.com/2010/01/how-to-layout-urdu-english-dictionary.html
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How To Layout A Book   

To layout a book or a manual like InPage user manual, you need to make use of the 

following features in InPage—  

· Double sided document  

· Master Page  

· Text box Tool  

· Title text box Tool  

· Linking Tool  

· Insert Page Number menu item  

· Urdu Page Numbers from Document Preferences  

  

To layout a book, follow these steps  

  

1. Make a new document by choosing New menu item from the File menu. A book is 

a double sided document with text flowing from one page to another. An urdu/Arabic 

document will be right to left whereas an English document will be left to right. In the new 

dialog enter the physical dimensions of your book, click double sided check box on, mark 

the inside and outside margins required for the text box and check the automatic check box 

on. If you wish to have columnar text then specify the number of columns in the columns 

field. On being satisfied with the various values click on the OK button.  

  

2. Now click on the master page button on the extreme bottom left corner of your 

document. Zoom with the right mouse button to fit in window view of your document. If 

facing pages is not clicked on, please select the facing pages menu item from view menu.  

You should now be able to see both the pages in a single window.  

3. If you had selected automatic text box ON in step 1, then proceed to the next step. 

Else you can actually make the text boxes of requisite size by selecting the text box tool 

and creating the text box. To link this text box with another one, click on the text box, 

choose the linking tool and create another text box on other master page.  

  

4. Using the title text box tool create title text box for each master page and place them 

where you want the page number to appear on each document page. Now using IBeam tool 

click on the title text box just created. Using the Insert menu choose the Page Number 

menu item. This will lead to insertion of hash(#) inside the title text box. You can now 

insert text before or after hash (in English/urdu/Arabic etc.)  

5. Using title text box you can insert some other book title that will appear on each 

page of your book.  

  

http://inpageurdu.blogspot.com/2010/01/how-to-layout-book.html
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Note: You can enter text or page number only in the title text box on the master pages.  

  

6. Now when go to document mode by clicking on master page icon again, you will 

notice that on document pages the text boxes and title text boxes appear at the positions 

where you placed them on the master page. You will also notice that in the page number 

title text box, appropriate page number appears. To select from various styles of page 

numbers, you can go to document preferences in the Preferences menu item in Edit menu. 

You can also specify that the page numbers appear in urdu by selecting the urdu page 

number option.  

  

7. Now you can choose the I-Beam tool and click on the text box of the first document 

page. Start entering text at the caret position.  

8. You will notice that as you enter text, pages are inserted automatically and the text 

flows from one text box of one page to another text box of another page.  

9. If you wish to begin a new chapter you can use the Page Breaks option of the 

Format Paragraph command.  

10. If you wish to keep the book in multiple files, then you can use Start Page Number 

field in the Document Preferences command of Edit menu to set the starting page number 

of succeeding chapters.  

Master Page   

You can go to a Master Page by clicking on the Master Page icon in the Status Bar. If your 

document is double sided then you will see two master pages. On the other hand if your 

document is single sided then you will see only one master page. The objects that are made 

on the master pages appear on the corresponding document pages.  

  

Modification of Master Objects   

  

If the master object is modified on the master page, then this change is reflected in this 

master object on all the other document pages.  

If the master object is modified on a document page then only that master object on that 

document page is modified.  

  

Attribute Level Linking of Master Object Copy   

  

Those attributes of the master object which are changed locally on the document page get 

delinked from the master object but other attributes remain linked. For example change the 

size of the master object copy locally in the document page; now go to this master object on 

the master page and change the fill color. Now all the master objects copy (including the 

http://inpageurdu.blogspot.com/2010/01/master-page.html
http://inpageurdu.blogspot.com/2010/01/master-page.html
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earlier modified master object copy) get the new fill color. Go back to the master Object on 

the master Page and change its size. This will result in all the master object copies except 

the one modified in step 1 getting the new size.  

  

Behavior of Text Boxes on a Master Page  

  

You cannot enter text into a Text Box on a master page. Thus if you move the mouse on top 

of a Text Box on a master page, the cursor will not change to IBEAM or Dotted I Beam, it 

will remain ARROW cursor. However, you can enter text in the normal way in copies of 

this master object on other document pages.  

  

Behavior of Title Text Boxes on a Master Page  

  

You can enter text into a Title Text Box on a master page. But you cannot enter text into 

the copy of this master Title Text Box on other pages. The copies take the text from the 

master Title Text Box. If a Title Text Box is drawn afresh on the document page and is not 

a copy of the master Title Text Box, then text can be entered into this Title Text Box. Uses 

of Title Text Box  

Title Text Boxes are used for entering Titles, headlines, page number, date etc. Behavior of 

Title Text Boxes on Master Page is different as compared to that of a Text Box. You can 

enter text into a Title box on a master page. You can verify this by moving the cursor on 

top of a Title Box Text Box. The cursor will change to IBEAM or DOTTED IBEAM. But 

for copies of this master object on other document pages, you cannot enter text or modify 

text formatting.             

Always bear in mind that 
your own resolution to  

succeed is more  
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important than any other.  

(Sardar Azeem)  

  
  

  


